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 Important Information

Warranty
The GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the date of shipment, 
as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves 
to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, 
due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other 
documentation. National Instruments will, at its option, repair or replace software media that do not execute programming 
instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not 
warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of 
the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of 
returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed 
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult 
National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages arising out of 
or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY 
WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR 
NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL 
INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of National Instruments will 
apply regardless of the form of action, whether in contract or tort, including negligence. Any action against National Instruments 
must be brought within one year after the cause of action accrues. National Instruments shall not be liable for any delay in 
performance due to causes beyond its reasonable control. The warranty provided herein does not cover damages, defects, 
malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or 
surges, fire, flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including 
photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written 
consent of National Instruments Corporation.

Trademarks
CVI™, LabVIEW™, Measurement Studio™, National Instruments™, NI-488.2™ , and ni.com™ are trademarks of 
National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL 
OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL 
COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE 
EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS 
CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL 
POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE 
FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, 
INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR 
FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC 
SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF 
THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER 
COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) 
SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM 
FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE 
REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO 
BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS 
FROM NATIONAL INSTRUMENTS' TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER 
MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT 
EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS 
ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL 
INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A 
SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND 
SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

FCC/Canada Radio Frequency Interference Compliance*

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. 
The FCC places digital electronics into two classes. These classes are known as Class A (for use in industrial-
commercial locations only) or Class B (for use in residential or commercial locations). Depending on where it is 
operated, this product could be subject to restrictions in the FCC rules. (In Canada, the Department of 
Communications (DOC), of Industry Canada, regulates wireless interference in much the same way.)

Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless 
products. By examining the product you purchased, you can determine the FCC Class and therefore which of the two 
FCC/DOC Warnings apply in the following sections. (Some products may not be labeled at all for FCC; if so, the 
reader should then assume these are Class A devices.)

FCC Class A products only display a simple warning statement of one paragraph in length regarding interference and 
undesired operation. Most of our products are FCC Class A. The FCC rules have restrictions regarding the locations 
where FCC Class A products can be operated.

FCC Class B products display either a FCC ID code, starting with the letters EXN, 
or the FCC Class B compliance mark that appears as shown here on the right.

Consult the FCC web site http://www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the 
instructions in this manual and the CE Mark Declaration of Conformity**, may cause interference to radio and 
television reception. Classification requirements are the same for the Federal Communications Commission (FCC) 
and the Canadian Department of Communications (DOC). 

Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate 
the equipment under the FCC Rules.

Class A
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to 
radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.

Class B
Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the user 
is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.



• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada.

European Union - Compliance to EEC Directives
Readers in the EU/EEC/EEA must refer to the Manufacturer's Declaration of Conformity (DoC) for information** 
pertaining to the CE Mark compliance scheme. The Manufacturer includes a DoC for most every hardware product 
except for those bought for OEMs, if also available from an original manufacturer that also markets in the EU, or 
where compliance is not required as for electrically benign apparatus or cables.

* Certain exemptions may apply in the USA, see FCC Rules §15.103 Exempted devices, and §15.105(c). 
Also available in sections of CFR 47.

** The CE Mark Declaration of Conformity will contain important supplementary information and instructions 
for the user or installer.
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About This Manual

This manual contains instructions to help you install and configure 

the National Instruments GPIB-ENET/100 and NI-488.2 for 

Windows Me/98/95.

This manual assumes that you are already familiar with Windows Me/98/95 

and with TCP/IP networks, and that your computer is connected to an 

Ethernet network. Before you can use the driver software for the 

GPIB-ENET/100, your host must be configured with TCP/IP protocols 

that conform to Windows sockets (WinSock) version 1.1 or higher.

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options 

to a final action. The sequence File»Page Setup»Options directs you to 

pull down the File menu, select the Page Setup item, and select Options 

from the last dialog box.

♦ The ♦ symbol indicates that the following text applies only to a specific 

operating system.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 

avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click on in the software, 

such as menu items and dialog box options. Bold text also denotes 

parameter names and LED names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 

to a key concept. This font also denotes text that is a placeholder for a word 

or value that you must supply.
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monospace Text in this font denotes text or characters that you should enter from the 

keyboard, sections of code, programming examples, and syntax examples. 

This font is also used for the proper names of disk drives, paths, directories, 

programs, subprograms, subroutines, device names, functions, operations, 

variables, filenames and extensions, and code excerpts.

monospace bold Bold text in this font denotes the messages and responses that the computer 

automatically prints to the screen.

Related Documentation

The following documents contain information that you might find helpful 

as you read this manual:

• ANSI/IEEE Standard 488.1-1987, IEEE Standard Digital Interface 

for Programmable Instrumentation

• ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats, 

Protocols, and Common Commands

• ANSI/IEEE Standard 802.3-1988, Information Processing Systems, 

Local Area Networks, Part 3

• Microsoft Win32 Software Developer Kit, Online Documentation for 

Win32 Overviews, and Win32 Reference
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1
Introduction

This chapter lists what you need to get started and optional equipment 

you can order, and briefly describes the GPIB-ENET/100 hardware and 

NI-488.2 for Windows Me/98/95.

What You Need to Get Started

Before you install your GPIB-ENET/100 hardware and NI-488.2 for 

Windows Me/98/95, make sure you have all of the following items:

❑ Windows Me/98/95 installed on your computer

❑ TCP/IP protocol installed on your computer

❑ GPIB-ENET/100, which is included in your kit

❑ GPIB-ENET/100 power supply, which is included in your kit

❑ One of the following power cords, which is included in your kit:

– U.S. standard power cord

– Switzerland power cord

– Australian power cord

– Universal European power cord

– North American power cord

– U.K. power cord

❑ The NI-488.2 for Windows CD, which is included in your kit

❑ One of the following Category 5 twisted-pair network cables, which 

you can purchase from National Instruments:

– Straight-through cable for connecting the GPIB-ENET/100 to a 

network hub

– Cross-over cable for connecting the GPIB-ENET/100 directly to 

a computer’s network interface card (NIC)
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❑ One of the following shielded GPIB cables, which you can purchase 

from National Instruments:

– Type X1 single-shielded cables (1, 2, or 4 m)

– Type X2 double-shielded cables (1, 2, or 4 m)

Caution To meet FCC emission limits for this device, you must use a shielded 

(Type X1 or X2) GPIB cable. If you operate this equipment with a non-shielded cable, 

it may interfere with radio and television reception.

Optional Equipment

This section lists optional equipment that you can order from National 

Instruments.

Optional Hardware
For information about ordering the following optional equipment, contact 

National Instruments:

• Serial or parallel bus extender and cables

• Bus expander/isolator

• GPIB mechanical switch

Multiple-Computer Software License
A multiple-computer software license allows one or more hosts on a single 

physical network to access one or more GPIB-ENET/100 boxes. For 

information about ordering a software license, contact National 

Instruments.

GPIB-ENET/100 Hardware Overview

The GPIB-ENET/100 high-speed interface controls GPIB instruments 

across Ethernet networks. You can use the GPIB-ENET/100 to access 

remote test equipment from anywhere in the world via TCP/IP protocols on 

10Base-T and 100Base-TX networks. By incorporating a new architecture, 

100Base-TX Ethernet, and HS488, the GPIB-ENET/100 delivers 

performance comparable to that of plug-in boards.

The GPIB-ENET/100 automatically detects if the available network is 

10Base-T (10 Mbits/s) or 100Base-TX (100 Mbits/s) and communicates at 

the highest available speed.
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You can use either the Dynamic Host Configuration Protocol (DHCP) or a 

simple Ethernet configuration utility to configure the GPIB-ENET/100 

without the need for any dip switches or jumpers. Installation options 

include rack mounting, DIN rail mounting, wall mounting, and stackable 

stand-alone use. You can stack the unit with other GPIB-ENET/100 units 

and additional National Instruments products including the ENET-232 

Series and ENET-485 Series serial controllers.

For more information about hardware specifications, refer to Appendix C, 

Specifications.

Feature Overview
With the GPIB-ENET/100, you gain all the features inherent in a 

networked device: fewer cabling distance restrictions, device sharing, 

and communication with devices throughout the Internet.

In a GPIB application, you are restricted to the distance limitations of the 

GPIB specification. However, you can overcome these restrictions because 

the GPIB-ENET/100 uses Ethernet, and can add an unlimited distance to 

your application simply by utilizing the distances available to you by using 

a networked device. Because the GPIB-ENET/100 uses standard Internet 

protocols, you can exploit the Internet to communicate with your GPIB 

instruments throughout the world.

LED Overview
Figure 1-1 shows the six light-emitting diodes (LEDs) on the 

GPIB-ENET/100. The LEDs are visible from the top and front of the unit.

Figure 1-1.  GPIB-ENET/100 Front Panel

1 Power/Ready LED
2 Ethernet LEDs

3 GPIB Port LEDs
4 Power Switch

1 2 3 4
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The LEDs show the current status of the GPIB-ENET/100. Table 1-1 

describes each LED.

NI-488.2 Overview

NI-488.2 includes a native, 32-bit multitasking Windows Me/98/95 driver 

that is fully Plug and Play aware.

The NI-488.2 software supports the concurrent use of multiple types of 

GPIB hardware. For example, you can communicate with GPIB devices 

through an AT-GPIB/TNT, a PCMCIA-GPIB, and a GPIB-ENET/100 in 

the same system at the same time. The NI-488.2 software is fully integrated 

into the operating system.

Table 1-1.  LED Descriptions

LED Description

PWR/RDY Flashes rapidly at start-up while performing self 

tests and when acquiring network parameters.

A steady yellow state indicates the box is ready for 

operation. Slow flashing pattern indicates an error 

occurred.

LINK

10/100

Indicates the GPIB-ENET/100 detected a twisted 

pair (10Base-T or 100Base-TX) link. The color 

indicates the connection speed. If yellow, the speed 

is 10 Mbits/s. If green, the speed is 100 Mbits/s.

TX Indicates the GPIB-ENET/100 is transmitting to 

the Ethernet network.

RX Indicates the GPIB-ENET/100 is receiving 

Ethernet network traffic.

TALK Indicates the GPIB-ENET/100 is configured as a 

GPIB Talker.

LISTEN Indicates the GPIB-ENET/100 is configured as a 

GPIB Listener.
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The NI-488.2 software, along with the GPIB hardware, transforms your 

computer into a GPIB Talker/Listener/Controller with complete 

communications and bus management capability. The NI-488.2 software 

includes the following components:

• Device driver

• Measurement & Automation Explorer, which gives you access to the 

NI-488.2 development utilities, including the NI-488.2 Getting Started 

Wizard and the NI-488.2 Troubleshooting Wizard

• Language interface libraries for Microsoft Visual C/C++ 2.0 or higher, 

Borland C/C++ 4.0 or higher, and Microsoft Visual Basic 4.0 or higher

• Example programs that use the NI-488.2 API

Time-Saving Development Tools

Your kit includes NI-488.2 for Windows Me/98/95. After you install your 

GPIB-ENET/100 and NI-488.2, you can use standard GPIB I/O functions 

in LabVIEW and Measurement Studio with your GPIB interface. If you 

already have one or more of these applications and want to use them 

with your GPIB-ENET/100, refer to your product documentation for 

information about GPIB I/O functions. For ordering information, contact 

National Instruments.

LabVIEW is a graphical programming environment you can use to acquire 

data from thousands of different instruments, including IEEE 488.2 

devices, VXI devices, serial devices, PLCs, and plug-in data acquisition 

boards. After you acquire raw data, you can convert it into meaningful 

results using the data analysis routines in LabVIEW. The LabVIEW 

instrument drivers reduce software development time because you do not 

have to program the low-level control of each instrument.

Measurement Studio bundles LabWindows/CVI for C, and measurement 

tools for Microsoft Visual C++ and Microsoft Visual Basic. Measurement 

Studio is designed for building measurement and automation applications 

with the programming environment of your choice:

• LabWindows/CVI is an interactive ANSI C programming 

environment designed for building virtual instrument applications. 

LabWindows/CVI delivers a drag-and-drop editor for building user 

interfaces, a complete ANSI C environment for building your test 

program logic, and a collection of automated code generation tools, 

as well as utilities for building automated test systems, monitoring 

applications, or laboratory experiments.
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• Measurement Studio Tools for Visual C++ takes advantage of COM 

and ActiveX technologies to help you build measurement and 

automation applications. With the Visual C++ application wizard and 

instrument classes, you can use the IEEE 488.2 library to send and 

receive commands to and from instruments, and you can use VISA, 

an industry-standard I/O library, to communicate with GPIB, VXI, 

or serial devices using the same set of components.

• For Visual Basic programmers, Measurement Studio includes a 

collection of ActiveX controls designed for building virtual 

instrumentation systems. You can use the GPIB, serial, and VISA I/O 

controls and property pages to configure communication with your 

instruments.

GPIB Analyzer is an optional tool available from National Instruments that 

is useful in troubleshooting a variety of IEEE 488 hardware and software 

problems. With its built-in time-stamping capability, you easily can 

determine the throughput and overhead of your GPIB systems. The GPIB 

Analyzer software for Windows Me/98/95 works with the AT-GPIB/TNT+ 

and PCMCIA-GPIB+ products, which provide GPIB Analyzer support 

along with the functionality of a high-performance GPIB Controller.
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2
Installation

This chapter describes how to install NI-488.2 for Windows Me/98/95 and 

the GPIB-ENET/100.

Note If you have a GPIB-ENET instead of a GPIB-ENET/100, refer to Getting Started 

with Your GPIB-ENET and NI-488.2 for Windows Me/98/95 for installation instructions.

Installing NI-488.2

Before you install the GPIB-ENET/100 hardware, complete the following 

steps to install the NI-488.2 software:

1. Insert the NI-488.2 for Windows CD.

2. When the NI-488.2 Software for Windows screen appears, click the 

Install NI-488.2 Software for Windows item, as shown in Figure 2-1.

Figure 2-1.  NI-488.2 Software for Windows CD Autorun Screen
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The setup wizard guides you through the necessary steps to install 

NI-488.2.

After you install NI-488.2, you are ready to install the GPIB-ENET/100 

hardware.

Add GPIB Hardware

Use the Add GPIB Hardware Wizard to inform Windows Me/98/95 that 

you are adding a GPIB-ENET/100 to your system. To do so, complete the 

following steps:

1. Select Start»Programs»National Instruments»NI-488.2»Add 

GPIB Hardware.

2. When the wizard prompts you for a type of hardware, select 

GPIB-ENET/100 and click Next to continue.

Figure 2-2.  Add GPIB Hardware Wizard Dialog Box

Restart Your System

Before you use the NI-488.2 software, you must restart your system.

When your system restarts, the NI-488.2 Getting Started Wizard launches 

automatically. Exit the NI-488.2 Getting Started Wizard. Later, you will be 

prompted to start the wizard again.
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Installing the GPIB-ENET/100 Hardware

Complete the following steps to install your GPIB-ENET/100.

Step 1. Record the Serial Number, Ethernet Address, 
and Default Hostname

When you configure the GPIB-ENET/100 for use on your network, 

you will need to differentiate it from other network devices. Every 

GPIB-ENET/100 has a unique serial number, Ethernet address, and 

default hostname.

1. Locate the serial number, Ethernet address, and default hostname on 

the GPIB-ENET/100 baseplate label, as shown in Figure 2-3.

2. Write down this information and keep it available so you can refer to 

it later as you configure the GPIB-ENET/100.

Note The Ethernet address is not the IP address. All devices on an Ethernet network 

are assigned a unique physical address—the Ethernet address—so they can communicate 

with each other.

Figure 2-3.  GPIB-ENET/100 Baseplate Identification Label

You can change the hostname after you finish the installation and 

configuration steps in this chapter. Refer to the Changing the Network 

Settings section in Chapter 3, Ethernet Configuration, for more 

information.

1 Serial Number
2 Ethernet Address

3 Default Hostname
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Step 2. Connect the Cables

Note If you do not have an Ethernet cable, as listed in the What You Need to Get Started 

section of Chapter 1, Introduction, contact National Instruments for ordering information.

Figure 2-4 shows the locations of the power, Ethernet, and GPIB 

connections on the rear panel of the GPIB-ENET/100.

Figure 2-4.  GPIB-ENET/100 Rear Panel

To connect your cables, complete the following steps:

1. Connect one end of your Ethernet cable to your GPIB-ENET/100. 

Connect the other end of the Ethernet cable to your Ethernet network. 

Make sure you comply with all IEEE 802.3 cabling restrictions.

2. Because AC outlets vary throughout the world, your kit includes a 

power cord that meets your local requirements in addition to a power 

supply. Figure 2-5 shows how to hook up your power cord and 

power supply.

a. Plug one end of the power cord you received in your kit into the 

power supply.

b. Screw the power connector on the other end of the power supply 

onto the power jack of the GPIB-ENET/100.

c. Plug the other end of the power cord into an AC outlet.

1 Configuration Reset Switch
2 Power Connection

3 Ethernet Connection
4 GPIB Connector

4

1

32
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Figure 2-5.  Connecting Power to the GPIB-ENET/100

Note Do not connect GPIB devices to your GPIB port until you configure NI-488.2 as 

described in Chapter 4, GPIB Configuration, and verify the installation as described in 

Chapter 5, Verify the Installation.

Step 3. Switch on Your GPIB-ENET/100
Before you power-on your GPIB-ENET/100, contact your network 

administrator to determine whether you need to configure your network 

settings manually using the NI Ethernet Device Configuration utility or 

use the Dynamic Host Configuration Protocol (DHCP) to perform the 

configuration automatically. For more information about DHCP, refer to 

the Using DHCP section in Chapter 6, Using Your GPIB-ENET/100 

and NI-488.2.

When you turn on the front-panel power switch, the PWR/RDY LED 

alternates rapidly between red and yellow while the GPIB-ENET/100 

completes its power-on self-tests and attempts to acquire its network 

parameters. Each Ethernet and GPIB LED lights up as its functionality is 

tested. By default, the GPIB-ENET/100 attempts its network configuration 

through DHCP.

1 To AC Outlet
2 Power Cord

3 Power Supply
4 To GPIB-ENET/100 Power Jack

1

2

3

4
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The time required for assigning the IP address depends on your network 

and the configuration of your GPIB-ENET/100. Allow up to 90 seconds 

and observe the state of the PWR/RDY LED to determine the outcome of 

the self tests. One of the following should occur:

• A steady yellow PWR/RDY LED indicates the GPIB-ENET/100 

passed its self tests and acquired its IP address. The unit is now ready 

to operate. When using DHCP, the GPIB-ENET/100 typically is ready 

to operate about 15 seconds after you power it on. Run the GPIB 

Configuration utility as described in Chapter 4, GPIB Configuration, 

to add the unit to your GPIB system.

• If the PWR/RDY LED continues to alternate rapidly between red and 

yellow, the unit was unable to use DHCP to configure its network 

parameters. If your network does not have DHCP, you must use the 

NI Ethernet Device Configuration utility, as described in Chapter 3, 

Ethernet Configuration, to give your unit its network configuration. 

If this utility is successful, the PWR/RDY LED should become steady 

yellow. Then you can run the GPIB Configuration utility as described 

in Chapter 4, GPIB Configuration. Refer to Appendix B, 

Troubleshooting and Common Questions, if the LED does not change 

to steady yellow.

• If the PWR/RDY LED is steady red, the GPIB-ENET/100 has an 

unrecoverable error. Contact National Instruments Technical Support.

• If the PWR/RDY LED blinks a slow red/yellow pattern, the 

GPIB-ENET/100 did not pass its self tests. Refer to Appendix A, 

PWR/RDY LED Signaling, to interpret the flash pattern before calling 

National Instruments Technical Support.

You can skip Chapter 3, Ethernet Configuration, if your GPIB-ENET/100 

can use DHCP, although you do need to use the NI Ethernet Device 

Configuration utility if you want to change the hostname from the default 

hostname listed on the baseplate label.

Note If at any time you want to return the GPIB-ENET/100 to its default configuration 

state as given on the baseplate label, press and hold the CFG RESET switch for three 

seconds while you switch the power on. This switch is located on the rear panel, as shown 

in Figure 2-4. Refer to the Using the CFG RESET Switch section in Chapter 6, Using Your 

GPIB-ENET/100 and NI-488.2, for more information.
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3
Ethernet Configuration

This chapter describes how to use the NI Ethernet Device Configuration 

utility to configure the network parameters of the GPIB-ENET/100. You 

can use this utility for any of the following purposes:

• Manually configure the network parameters or enable DHCP

• Verify or change the hostname

• Add or change a comment to help identify the device

If DHCP is available on your network, it configures the network parameters 

for your GPIB-ENET/100 at startup, as described in the Step 3. Switch on 

Your GPIB-ENET/100 section of Chapter 2, Installation. In this case, using 

the NI Ethernet Device Configuration utility is not required.

If DHCP is not available, the unit automatically enters network 

configuration mode if it is configured with the factory default settings. 

The GPIB-ENET/100 must be in this mode before you can make changes 

to the network parameters.

You also can enter this mode during normal operation by pressing and 

holding the CFG RESET switch for three seconds. Refer to the Using the 

CFG RESET Switch section in Chapter 6, Using Your GPIB-ENET/100 

and NI-488.2 for more information on using this switch.

While in network configuration mode, the PWR/RDY LED alternates 

rapidly between red and yellow, and normal operation is halted.

Using the NI Ethernet Device Configuration Utility

If your network administrator tells you to assign the IP address manually, 

run the NI Ethernet Device Configuration utility. To do so, complete the 

following steps:

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.
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3. Right-click the appropriate GPIB-ENET/100 item and select Device 

Configuration from the drop-down menu that appears. You can 

identify your device by the Ethernet address or the serial number found 

on the GPIB-ENET/100 baseplate label. 

Figure 3-1.  NI Ethernet Device Configuration Utility

4. The NI Ethernet Device Configuration window displays a list of 

National Instruments Ethernet devices found on your subnet, sorted by 

model. Figure 3-1 shows an example of this display. The listed devices 

can be in one of four possible states, as indicated in the 

IP address/hostname column:

• A hostname indicates the device has successfully been configured 

by DHCP.

• A numerical IP address indicates the device has successfully been 

configured with a static IP address.

• *Unconfigured* indicates the device is configured to use DHCP, 

but DHCP failed to attain network parameters.

• *Busy* indicates the device is configured to use DHCP and 

currently is attempting to acquire network parameters.

Click Properties... for any of the following reasons:

• You need to configure an unconfigured IP address.

• You need to change the current network parameters.

• You previously used DHCP, but it is no longer available.

• You are using DHCP and need to change the hostname of the 

GPIB-ENET/100.
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• The IP address/hostname column displays an exclamation 

point (!) next to your GPIB-ENET/100, indicating a configuration 

problem. Refer to the Verifying the Hostname section for help 

fixing this problem.

• You want to add or change a comment to help identify the device.

Click Refresh if you do not see your GPIB-ENET/100 in the list of 

Ethernet devices, or to discover a device that you recently added to 

the subnet.

Click Exit if you are using DHCP and you do not need to change the 

hostname of the GPIB-ENET/100, or if you are finished using the 

NI Ethernet Device Configuration utility.

Changing the Network Settings

1. When you select Properties... from the NI Ethernet Device 

Configuration window, a Properties window for your 

GPIB-ENET/100 appears, similar to the example shown in Figure 3-2.

Figure 3-2.  Properties Window for an Unconfigured GPIB-ENET/100

The current hostname is displayed. The hostname associates a name 

with a numerical IP address. Hostname is a required field.
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The GPIB-ENET/100 attempts to use the hostname when registering 

with DHCP. Many DHCP servers have the ability to register the 

hostname and the assigned IP address. You then can reliably use the 

hostname to communicate with your GPIB-ENET/100 even if the 

numerical IP address changes.

However, some DHCP servers do not implement hostname 

registration. The GPIB-ENET/100 requires Domain Name Server 

(DNS) registration when using DHCP. If your DHCP server does not 

support DNS registration, you must use static network parameters. 

Consult your network administrator for more details.

2. In the Properties window, select either Obtain an IP address 

automatically (DHCP) or Use the following IP settings.

3. If you select Obtain an IP address automatically (DHCP), you do 

not need to enter any network parameters unless you want to change 

the hostname of the Ethernet device. If you select Use the following 

IP settings, enter the network parameters you have chosen for the host 

IP address, subnet mask, gateway IP, and DNS server IP, as in the 

example shown in Figure 3-3. Refer to the next section, Static IP 

Parameters, for more information.

Figure 3-3.  Specifying IP Settings
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Note The IP settings in Figure 3-3 are shown only as an example of the format.

4. You can enter an optional comment to help you identify each device.

5. Click OK to configure the device, or Cancel to exit without saving the 

configuration changes.

6. Click Exit to close the NI Ethernet Device Configuration utility.

The device automatically reboots with the new configuration in effect.

Static IP Parameters
If DHCP is not available, you must provide the GPIB-ENET/100 with 

several important network parameters. These parameters are listed below.

• IP address—The unique, computer-readable address of a device on 

your network. An IP address typically is represented as four decimal 

numbers separated by periods (for example, 130.164.54.215). 

Refer to the next section, Choosing a Static IP Address.

• Subnet mask—A code that helps the network device determine 

whether another device is on the same network or a different network.

• Gateway IP—The IP address of a device that acts as a gateway, which 

is a connection between two networks. If your network does not have 

a gateway, set this parameter to 0.0.0.0.

• DNS Server—The IP address of a network device that stores 

hostnames and translates them into IP addresses. If your network does 

not have a DNS server, set this parameter to 0.0.0.0.

Choosing a Static IP Address

For a Network Administered by a Network 
Administrator
If you are adding the GPIB-ENET/100 to an existing Ethernet network, you 

must choose IP addresses carefully. Contact your network administrator to 

obtain an appropriate static IP address for your GPIB-ENET/100. Also 

have the network administrator assign the proper subnet mask, gateway, 

and DNS server addresses.
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For a Network without a Network Administrator
If you are assembling your own small Ethernet network, you can choose 

your own IP addresses. The format of the IP addresses is determined by 

the subnet mask. You should use the same subnet mask as the computer 

you are using with your GPIB-ENET/100. If your subnet mask is 

255.255.255.0, the first three numbers in every IP address on the 

network must be the same. If your subnet mask is 255.255.0.0, only the 

first two numbers in the IP addresses on the network must match.

For either subnet mask, numbers between 1 and 254 are valid choices for 

the last number of the IP address. Numbers between 0 and 255 are valid for 

the third number of the IP address, but this number must be the same as 

other devices on your network if your subnet mask is 255.255.255.0.

Table 3-1 shows examples of valid and invalid IP addresses for a network 

using subnet mask 255.255.255.0. All valid IP addresses contain the 

same first three numbers. The IP addresses in this table are for example 

purposes only.

If you are setting up your own network, you probably do not have a gateway 

or DNS server, so you should set these values to 0.0.0.0.

Table 3-1.  Valid and Invalid IP Addresses for Subnet Mask 255.255.255.0

IP Address Comment

123.234.45.211 Valid.

123.234.45.213 Valid. The first three numbers match the previous 

IP address. The fourth number must be a unique 

number in the range of 1 to 254.

123.202.45.214 Invalid. Second number does not match the 

previous IP addresses. The first three numbers 

must match on all IP addresses with subnet mask 

255.255.255.0.

123.234.45.0 Invalid. The first three numbers are valid but the 

fourth number cannot be 0.

123.234.45.255 Invalid. The first three numbers are valid but the 

fourth number cannot be 255. 
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Tip To find out the network settings for your computer, perform the following steps:

♦ Windows Me/98

1. Open a DOS prompt.

2. Type IPCONFIG.

3. Press <Enter>.

If you need more information, you can run ipconfig with the /all option 

by typing IPCONFIG /all at the DOS prompt. This shows you all of the 

settings for the computer. Make sure you use the settings for the Ethernet 

adapter you are using to communicate with the GPIB-ENET/100.

♦ Windows 95

1. Open a DOS prompt.

2. Type WINIPCFG.

3. Press <Enter>.

4. Select the Ethernet adapters you are using to communicate with the 

GPIB-ENET/100 from the drop-down list.

Verifying the Hostname
The NI Ethernet Device Configuration utility automatically verifies that the 

hostname for each DHCP-enabled device matches the DNS entry for the 

assigned IP address. This verification process automatically occurs when 

you either run the utility or click Refresh. The utility alerts you as shown 

in Figure 3-4 if it detects a problem with the network settings.

Figure 3-4.  Hostname Verification Error Detected
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To correct the problem with the hostname, complete the following steps:

1. Locate the device that has a problem. This is indicated by an (!) on the 

device icon, as shown previously in Figure 3-1.

2. Select Properties.... A dialog box similar to the following appears.

Figure 3-5.  Resolving a Hostname Verification Error

3. The utility gives you four options for resolving the verification error. 

Select the one that best fits your situation and click OK.

• Change the device’s hostname to match the DNS entry. Use 

this option if you want to accept the hostname assigned by the 

DHCP server, or if you cannot contact the network administrator 

to change the DNS entry.

• Use static network parameters instead of DHCP. Use this 

option if you cannot use the hostname assigned by the DHCP 

server. Contact your network administrator to obtain a valid IP 

address, subnet, and gateway. This option disables DHCP on the 

device.

• Edit the current hostname. Use this option to change the 

hostname to a name other than either the configured hostname or 

the name assigned by the DHCP server. Contact your network 

administrator to obtain a valid name.
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• Keep the existing hostname. Use this option if you wish to keep 

the previously assigned hostname. If you select this option, 

contact your network administrator to change the DNS entry.

4. Review the network parameter settings in the Properties window.

5. Confirm that the device is in network configuration mode and click 

OK. The device reboots with the new settings in effect.

6. After the device reboots, click Refresh to verify that the hostname is 

now valid.
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4
GPIB Configuration

This chapter describes how to configure your Windows Me/98/95 machine 

to use the GPIB-ENET/100.

Configuring the NI-488.2 Software Characteristics

To configure the NI-488.2 software, complete the following steps:

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Run the NI Ethernet Device Configuration utility. Right-click the 

GPIB-ENET/100 item and select Device Configuration from the 

drop-down menu that appears.

4. Record the IP Address or hostname of your device from the 

IP address/hostname column. You can identify your device by the 

Ethernet address or serial number found on the GPIB-ENET/100 

baseplate label.

5. Exit the NI Ethernet Device Configuration utility.

6. Right-click the GPIB-ENET/100 item and select Properties from the 

drop-down menu that appears. This launches the GPIB Configuration 

utility.

7. To configure the network addresses assigned to your GPIB-ENET/100, 

complete the following steps:

a. Click on the Network Settings tab.

b. Type the IP address or hostname that you recorded in step 4 in the 

IP Address field, as shown in Figure 4-1.



Chapter 4 GPIB Configuration

GPIB-ENET/100 for Windows Me/98/95 4-2 ni.com

Figure 4-1.  Network Settings Tab

The NI-488.2 Configuration utility context-sensitive online help contains 

all of the information that you need to configure the NI-488.2 software 

properly. To view the online help, click on the question mark (?) button 

in the toolbar and click on any item for more information about it.

Note In the online help, all references to the GPIB-ENET apply also to the 

GPIB-ENET/100.
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5
Verify the Installation

This chapter describes how to verify the hardware and software installation.

Power-On Self Tests

When you power on your GPIB-ENET/100, the PWR/RDY LED 

alternates rapidly between red and yellow while the GPIB-ENET/100 

completes its power-on self-tests and acquires its network parameters, 

as described in the Step 3. Switch on Your GPIB-ENET/100 section in 

Chapter 2, Installation.

The power-on self tests take about 15 seconds to complete when using 

DHCP. The time required for the IP address assignment is dependent on 

your network and the configuration of your GPIB-ENET/100. When the 

tests are successful and the IP address is assigned, the PWR/RDY LED 

remains steady yellow, indicating that the GPIB-ENET/100 is ready to 

operate.

If the PWR/RDY LED continues to flash for more than one minute, refer 

to the Troubleshooting Hardware Problems section in Appendix B, 

Troubleshooting and Common Questions.

Run the NI-488.2 Getting Started Wizard

To test the hardware and software installation, run the NI-488.2 Getting 

Started Wizard. Select Start»Programs»National Instruments»

NI-488.2»Getting Started and follow the instructions on the screen.

The NI-488.2 Getting Started Wizard, shown in Figure 5-1, verifies the 

hardware and software installation and helps you begin to communicate 

with your GPIB instrument.
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Figure 5-1.  NI-488.2 Getting Started Wizard Dialog Box

When you click Verify your hardware and software installation, the 

NI-488.2 Troubleshooting Wizard tests your GPIB interface and displays 

the results, as shown in as shown in Figure 5-2.

Note The GPIB cable must be disconnected from your GPIB interface before you run the 

NI-488.2 Troubleshooting Wizard.

Figure 5-2.  NI-488.2 Troubleshooting Wizard
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Connecting the GPIB Cable

When you finish verifying the installation, you can connect the GPIB cable 

to your GPIB-ENET/100.

Note If you do not have a GPIB cable, as listed in the What You Need to Get Started 

section of Chapter 1, Introduction, contact National Instruments for ordering information.

Connect one end of your GPIB cable to your GPIB-ENET/100 and tighten 

the thumb screws on the connector. Connect the other end of your GPIB 

cable to your GPIB system. Make sure you comply with all IEEE 488.1 

cabling restrictions and use only shielded GPIB cables.
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6
Using Your GPIB-ENET/100 
and NI-488.2

This chapter describes how to use the following options available with the 

GPIB-ENET/100 and NI-488.2 for Windows Me/98/95:

• NI-488.2 Getting Started Wizard

• Dynamic Host Configuration Protocol (DHCP)

• Configuration Reset (CFG RESET) switch

• Firmware update utility

NI-488.2 Getting Started Wizard

The NI-488.2 Getting Started Wizard helps you get started with GPIB 

instrument communication using the Measurement & Automation 

Explorer. To run the NI-488.2 Getting Started Wizard, select 

Start»Programs»National Instruments»NI-488.2»Getting Started.

After the NI-488.2 Getting Started Wizard runs the NI-488.2 

Troubleshooting Wizard to verify the installation, click Communicate 

with your instrument. The Getting Started Wizard then steps you through 

communicating with your GPIB instruments via the Measurement & 

Automation Explorer.
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Figure 6-1.  Communicating with Your Instrument

Using DHCP

The Dynamic Host Configuration Protocol (DHCP) is designed for large 

networks in which networking devices are transient and network 

parameters cannot be statically assigned and thus tied to specific devices. 

DHCP eases the addition of networking devices onto a network by having 

a server assign necessary network parameters, including the IP address, 

the netmask, and router information, to a newly attached network device. 

Optionally, if the device provides a hostname with the configuration 

request, DHCP may attempt to configure your network to recognize the 

device with the requested hostname.

DHCP requires a Domain Name Server (DNS) to associate the numerical 

IP address assigned with the requested hostname. Within the past few years, 

an Internet community standard has emerged to provide a standardized way 

for these services to provide dynamic domain name services. Using this 

standard, after DHCP assigns the numerical IP address, it can communicate 

with DNS to register the newly assigned IP address with the requested 

hostname. However, the complexity of DHCP and dynamic name 

registration typically requires active management by a corporate MIS 

department, or equivalent, because of several risks for failure.

One possible failure can occur if the pool of available addresses contains 

no more unassigned IP addresses. This problem is evident if DHCP fails 

to work and the PWR/RDY LED continues to flicker for longer than 

90 seconds at power on. In this situation, you will need to obtain a static IP 

address from your network administrator and configure the device yourself 

using the NI Ethernet Device Configuration utility. Refer to the Choosing 

a Static IP Address section in Chapter 3, Ethernet Configuration, for more 
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information. Notice that if DHCP fails to assign you an address, the current 

subnet might not have an address available for you to use. In this case, you 

may have to move your product to another subnet where there is an 

available IP address.

Failure also happens if communication between DHCP and DNS does not 

occur. In this situation, DHCP assigns an address to the device, but you 

cannot communicate to it using the hostname you assigned. Your network 

administrator may have to manually insert the hostname into the DNS table. 

Alternatively, you can use the NI Ethernet Device Configuration utility to 

determine the hostname associated with your assigned IP address, and 

change the hostname to match the DNS entry. Refer to the Verifying the 

Hostname section in Chapter 3, Ethernet Configuration, for more 

information.

Because there are many other possible reasons for failure, contact your 

network administrator if you are having problems getting DHCP to work. 

When you can use DHCP and DNS successfully, you can use the hostname 

form of the IP address to communicate with your product—even if the 

numerical IP address changes with successive reboots.

If you are setting up a small network for your instrumentation system, 

it is recommended to use static IP addresses, because they are easier to 

implement and maintain. In this system, you can safely use the numerical 

form of the IP address to communicate with your product because the 

address is unlikely to change. Small networks are less likely to have domain 

name services available that would resolve the hostname into a numerical 

IP address.

Using the CFG RESET Switch

The Configuration Reset (CFG RESET) switch is a recessed switch located 

beside the ENET connector on the rear panel. Refer to Figure 2-4 for an 

illustration of its location.

This switch performs two functions, depending on whether you press it 

while switching the power on or during operation.

Using the CFG RESET Switch during Operation
While the GPIB-ENET/100 is operational, as indicated by a steady yellow 

PWR/RDY LED, you can use the CFG RESET switch to place the box into 

network configuration mode. You then can use the NI Ethernet Device 

Configuration utility as described in Chapter 3, Ethernet Configuration.
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This special mode ensures that network parameters are not changed while 

in use. Because you cannot change the network parameters unless you 

deliberately place the GPIB-ENET/100 into network configuration mode, 

the parameters are protected while in normal operation. Hosts cannot 

connect to the GPIB-ENET/100 while it is in network configuration mode.

Note Pressing the CFG RESET switch has no effect if hosts are currently connected.

Close all connections, then press and hold the CFG RESET switch for three 

seconds. If you release the switch prior to three seconds, the 

GPIB-ENET/100 continues to operate normally.

The PWR/RDY LED goes through the following changes during these 

three seconds:

1. The LED begins slowly alternating between red and yellow.

2. The alternating pattern increases in tempo.

3. At three seconds, the PWR/RDY LED becomes steady red. This 

indicates the GPIB-ENET/100 is ready to enter network configuration 

mode.

4. Now release the CFG RESET switch. The PWR/RDY LED alternates 

rapidly between red and yellow to indicate the GPIB-ENET/100 is 

now in network configuration mode.

This mode remains in effect until you switch off the GPIB-ENET/100 or 

you use the NI Ethernet Device Configuration utility to change its network 

characteristics. The GPIB-ENET/100 automatically reboots when you exit 

the utility.

Using the CFG RESET Switch at Power-On
If you want to reset the unit to its default network characteristics, you can 

use the CFG RESET switch at power-on. By pressing and holding the CFG 

RESET switch while you power on the GPIB-ENET/100, the network 

parameters revert to the default settings as defined on the baseplate label.

You must press and hold the switch for three seconds. If you release 

the switch prior to three seconds, no change occurs to the network 

configuration, and the GPIB-ENET/100 continues to boot normally.
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The PWR/RDY LED goes through the following changes during these 

three seconds:

1. The LED begins slowly alternating between red and yellow.

2. The alternating pattern increases in tempo.

3. At three seconds, the PWR/RDY LED becomes steady red. This 

indicates the network configuration will be set to the factory default 

settings.

4. When you release the CFG RESET switch, the box continues to boot 

as normal, and the PWR/RDY LED indicates the boot process as 

described in Table 1-1, LED Descriptions.

Updating the Firmware

NI-488.2 for the GPIB-ENET/100 and Windows Me/98/95 contains a 

firmware update utility you can use to access new features that may be 

added to the GPIB-ENET/100 in the future. You must update the firmware 

to take advantage of any new features.

The GPIB-ENET/100 always ships with the most recent firmware. You do 

not need to run the firmware update utility on a new product. You can obtain 

the latest upgrade at the following path:

ftp://ftp.ni.com/support/gpib/firmware/GPIBENET100/

You need to know either the IP address or hostname of your 

GPIB-ENET/100 before you run the NI Ethernet Device Firmware Update 

utility. If you do not remember this information, first run the NI Ethernet 

Device Configuration utility, as follows.

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Right-click on the GPIB-ENET/100 item and select Device 

Configuration from the drop-down menu that appears.

Refer to Chapter 3, Ethernet Configuration, for more information on using 

the NI Ethernet Device Configuration utility.

Caution Do not power-off the GPIB-ENET/100 or disconnect the power supply while 

running the NI Ethernet Device Firmware Update utility. Doing so will damage the unit. 

The GPIB-ENET/100 reboots automatically when the update completes.
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Note The NI Ethernet Device Firmware Update utility cannot update the firmware while 

any network connections are active. Close any open connections before you attempt a 

firmware update. Hosts cannot connect to the GPIB-ENET/100 while it is updating the 

firmware.

To start the Update Firmware utility, complete the following steps:

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Right-click on the GPIB-ENET/100 item and select Update 

Firmware from the drop-down menu that appears.

Figure 6-2 shows the NI Ethernet Device Firmware Update utility.

Figure 6-2.  NI Ethernet Device Firmware Update Utility

4. Enter the IP address or the hostname of the GPIB-ENET/100 in the 

IP address or hostname edit box. An example of an IP address is 

137.65.220.40. An example of a hostname is myenet1.

5. Enter the full path of the binary file where the firmware is located in 

the EEPROM binary image filename edit box. You also can click 

Browse... to locate the file. 

6. Click Update to update the firmware. The NI Ethernet Device 

Firmware Update utility communicates with the specified 

GPIB-ENET/100 to verify the box has no open network connections 

and determine the current version of the firmware in the unit. A dialog 

box reports that the update utility is searching for the Ethernet device.
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7. The utility prompts you to confirm the change you are about to 

perform. Click OK to continue. As the update utility transfers the 

firmware image to your GPIB-ENET/100, the Update Progress status 

bar fills, and the Current status box describes each step in the process. 

The Current status box reports whether the firmware update 

completed successfully or failed. The GPIB-ENET/100 automatically 

reboots with the new firmware in effect.

8. Click Exit to close the NI Ethernet Device Firmware Update utility.
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A
PWR/RDY LED Signaling

This appendix describes how to interpret the PWR/RDY LED error codes.

PWR/RDY LED Overview

The PWR/RDY LED has several purposes on the GPIB-ENET/100. 

When you first power on the unit, the PWR/RDY LED alternates rapidly 

between red and yellow while it completes its power-on self-tests and 

acquires network parameters. When the tests complete successfully and the 

IP address is assigned from either nonvolatile memory or the network, the 

PWR/RDY LED remains steady yellow, indicating that the unit is ready 

to operate.

The PWR/RDY LED also alternates rapidly between red and yellow 

while the device is in network configuration mode. At other times, the 

PWR/RDY LED blinks slowly in a recognizable pattern to alert you of 

internal errors. Use this appendix to interpret and record the pattern that the 

PWR/RDY LED flashes, and then contact National Instruments.

Note By recording the PWR/RDY LED status messages before calling National 

Instruments, you can save yourself time, and the Product Support Department can answer 

your questions more accurately and efficiently. Do not switch off power to your 

GPIB-ENET/100 before recording the flashing PWR/RDY LED pattern.

PWR/RDY LED signaling can report up to 81 different errors. The errors 

are numbered from 11 to 99 and are reported through sequences of 

PWR/RDY LED flashes.

Note There is no zero in any error message. This means that error message numbers 0–10, 

20, 30, 40, 50, 60, 70, 80, and 90 are not possible.
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Step 1. Count the Long Flashes

A three-second interval, during which the PWR/RDY LED is yellow, 

separates each repetition of the sequence. The sequence begins with a 

series of long one-second flashes—that is, one second red, one second 

yellow. These long flashes represent the digit in the tens column. There 

can be one to nine long flashes, which represent digits 1 through 9. For 

example, one long flash represents the digit 1 in the tens column, and nine 

long flashes represent the digit 9 in the tens column.

Step 2. Count the Short Flashes

The long flashes are followed by shorter flashes; each short flash lasts 

about one-fifth of a second—that is, one-fifth of a second red, one-fifth of 

a second yellow. These short flashes represent the digit in the ones column. 

Again, there can be one to nine flashes, which represent the digits 1 through 

9. For example, one short flash represents the digit 1 in the ones column, 

and nine short flashes represent the digit 9 in the ones column.

Using this method, the PWR/RDY LED flashes the following sequence to 

represent status message 11:

<three seconds yellow> <one long red flash> <one short red flash> 

<three seconds yellow>…

The PWR/RDY LED flashes the following sequence to represent status 

message 31:

<three seconds yellow> <three long red flashes> <one short red flash> 

<three seconds yellow>…

Step 3. Record Your Status Code Number

When you have computed your error message number, write it down and 

also note the ON/OFF state of the LINK, TX, and RX LEDs. Have this 

information available when calling National Instruments.
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B
Troubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers some 

common questions.

Troubleshooting Hardware Problems

• Verify that all cables are securely connected to the GPIB-ENET/100.

• Verify that the unit is plugged in and powered on.

• Verify with the network administrator that your IP address is valid and 

that the network is set up to recognize the IP address properly.

• If you configured the IP address manually using the NI Ethernet 

Device Configuration utility, verify that you have correctly followed 

the steps in Chapter 3, Ethernet Configuration.

• If the PWR/RDY LED continues to flash rapidly after 90 seconds, the 

GPIB-ENET/100 is unable to obtain its IP address from the network. 

Check with your network administrator to verify your IP address and 

make sure that you recorded the Ethernet address correctly. 

• If the PWR/RDY LED is blinking in a slower red/yellow pattern, the 

GPIB-ENET/100 is reporting an internal error. Refer to Appendix A, 

PWR/RDY LED Signaling, to interpret the error code and contact 

National Instruments.
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Troubleshooting EDVR Error Conditions

In some cases, calls to NI-488 functions or IEEE 488.2-style functions may 

return with the ERR bit set in ibsta and the value EDVR in iberr. The 

value stored in ibcntl is useful in troubleshooting the error condition.

EDVR Error Condition with ibcntl Set to 0xE028002C (-534249428)
If a call is made with a board number that is within the range of allowed 

board numbers (typically 0 to 31), but which has not been assigned to a 

GPIB interface, an EDVR error condition occurs with ibcntl set to 

0xE028002C. You can assign a board number to a GPIB interface by 

running the GPIB Configuration utility and selecting an interface name. 

Refer to Configuring the NI-488.2 Software Characteristics, in Chapter 4, 

GPIB Configuration, for information about how to configure NI-488.2.

EDVR Error Condition with ibcntl Set to 0xE0140025 (-535560155)
If a call is made with a board number outside the range of allowed board 

numbers (typically 0 to 31), an EDVR error condition occurs with ibcntl 

set to 0xE0140025.

EDVR Error Condition with ibcntl Set to 0xE0140035 (-535560139)
If a call is made with a device name that is not listed in the logical device 

templates that are part of the GPIB Configuration utility, an EDVR error 

condition occurs with ibcntl set to 0xE0140035.

EDVR Error Conditions with ibcntl in the Range from 0xE1002710 
(-520083696) to 0xE1002EE0 (-520081696)

These errors are returned from the WinSock Interface. The lower 16 bits of 

ibcntl specify the actual WinSock Interface error. Refer to your WinSock 

Interface documentation for more information about the specific error.

EDVR Error Condition with ibcntl Set to 0xE1000054 (-520093612)
You are attempting to communicate with a GPIB-ENET/100 that does not 

have a hostname (IP address) specified in the GPIB Configuration utility. 

Refer to Configuring the NI-488.2 Software Characteristics, in Chapter 4, 

GPIB Configuration, for information about how to configure NI-488.2.
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EDVR Error Condition with ibcntl set to 0xE1030043 (-519897021)
If you enabled DOS NI-488.2 support and tried to run an existing DOS 

NI-488.2 application that was compiled with an older, unsupported DOS 

language interface, an EDVR error condition occurs with ibcntl set to 

0xE1030043.

EDVR Error Condition with ibcntl Set to 0xE100004E (-520093618)
You are attempting to communicate with a GPIB-ENET/100 that has a 

firmware revision that is incompatible with the current driver. Use the 

NI Ethernet Device Firmware Update utility to upgrade the firmware to a 

compatible version.

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Right-click on the GPIB-ENET/100 item and select Update 

Firmware from the drop-down menu that appears.

Missing WinSock Support

WinSock support is enabled and configured in the Network Control Panel 

applet. To configure WinSock support, perform the following steps:

1. Select Start»Settings»Control Panel.

2. Double-click the Network icon.

For Windows Me, if you do not see the Network icon, select view all 

Control Panel options on the left side of the window.

3. In the Network dialog box, click the Configuration tab and 

click Add.

4. In the Select Network Component Type dialog box, select Protocol 

from the list box and click Add.

5. In the Select Network Protocol dialog box, select the appropriate 

Manufacturers and Network Protocols from the list boxes.

Because many different network providers and protocols are available 

in this dialog box, consult your network provider documentation to 

determine which protocol provides WinSock support from that vendor. 

For example, to enable Microsoft WinSock support, select Microsoft 
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in the Manufacturers list box and TCP/IP in the Network Protocols 

list box. For instructions on how to configure the selected protocol, 

consult your network provider documentation.

6. Click OK.

7. After you enable and configure WinSock support, run the NI-488.2 

Troubleshooting Wizard. To do so, start the Measurement & 

Automation Explorer by selecting Start»Programs»National 

Instruments»NI-488.2»Explore GPIB. Within the Measurement & 

Automation Explorer, select Help»Troubleshooting»NI-488.2 

Troubleshooting Wizard.

Common Questions

I currently do not have a WinSock provider installed. What do I need 

to do to install a WinSock provider?

Before you can use the driver software for the GPIB-ENET/100, you must 

have a WinSock interface, version 1.1 or higher, installed. You can install a 

WinSock interface from Microsoft or another network vendor. Refer to the 

Missing WinSock Support section of this appendix for information about 

how to install and configure WinSock support.

My driver is not communicating with the GPIB-ENET/100. What 

should I do?

Make sure that the GPIB-ENET/100 is configured properly, as described in 

Chapter 4, GPIB Configuration. Then run the Troubleshooting Wizard as 

described in Chapter 5, Verify the Installation.

My I/O worked with a board interface, but it times out when I use the 

GPIB-ENET/100. What should I do?

Network communication is slower than straight cable 

communication.You might need to raise the default Timeout value.

1. Select Start»Programs»National Instruments»NI-488.2»Explore 

GPIB to start the Measurement & Automation Explorer.

2. Under Measurement & Automation, expand the Devices and 

Interfaces folder.

3. Right-click on the GPIB-ENET/100 item and select Properties from 

the drop-down menu that appears.

4. Click on the NI-488.2 Settings tab and change the I/O Timeout 

setting.
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I powered off my GPIB-ENET/100 before recording the flashing 

PWR/RDY LED pattern. What should I do?

Try to duplicate the error before calling National Instruments for 

assistance. Recording the PWR/RDY LED pattern is not critical to the 

operation of your GPIB-ENET/100, but it saves you time and helps 

National Instruments diagnose the problem quickly and accurately.

How can I determine if my GPIB hardware and the NI-488.2 software 

are installed properly?

Run the NI-488.2 Getting Started Wizard by selecting Start»Programs»

National Instruments»NI-488.2»Getting Started.

Can I control the GPIB-ENET/100 and other GPIB interfaces from the 

same computer?

Yes. The Windows Me/98/95 driver supports a full range of GPIB 

interfaces simultaneously.

I have a GPIB-ENET. Can I use the GPIB-ENET and GPIB-ENET/100 

in the same system?

Yes, this version of NI-488.2 supports systems containing both products as 

well as systems containing only one of the two products. Measurement & 

Automation Explorer will guide you through the configuration of the 

product.

How many GPIB interfaces can I configure for use with the NI-488.2 

software?

You can configure the NI-488.2 software to communicate with up to 

100 GPIB interfaces.

How many devices can I configure for use with NI-488.2 for 

Windows Me/98/95?

NI-488.2 for Windows provides a total of 1,024 logical devices for 

applications to use. The maximum number of physical devices you should 

connect to a single GPIB interface is 14, or fewer, depending on your 

system configuration.

Can I use the NI-488 and NI-488.2 calls together in the same 

application?

Yes, you can mix NI-488 functions and IEEE 488.2-style-functions.
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How should I check for errors in my GPIB application?

Examine the value of ibsta after each NI-488 or NI-488.2 call. If a call 

fails, the ERR bit of ibsta is set and an error code is stored in iberr. 

For more information about global status variables, refer to Chapter 3, 

Developing Your Application, in the NI-488.2 User Manual for Windows.

Why does the NI Ethernet Device Configuration utility list my box as 

*BUSY* when I know my network uses DHCP?

For up to one minute, the GPIB-ENET/100 attempts to retrieve network 

parameters from a DHCP server. During this time, *BUSY* appears in the 

NI Ethernet Device Configuration utility display. If this status does not 

change, there are several reasons why DHCP may fail to respond. One of 

the most likely reasons is that your subnet has no more available addresses 

to assign using DHCP. Please consult your network administrator to 

determine the specific reason for the problem.

I just added a GPIB-ENET/100 to the network, but it does not show up 

in the NI Ethernet Device Configuration utility. What is the problem?

Allow at least 15 seconds for the GPIB-ENET/100 to complete its 

power-on self tests before launching the utility or clicking Refresh. 

Communication between the NI Ethernet Device Configuration utility and 

the GPIB-ENET/100 is not guaranteed. Though unlikely, it is possible that 

the communication gets lost in the network. Click Refresh more than once 

before concluding the device is not discovered.

Verify that the GPIB-ENET/100 shares the same subnet as the computer 

running the NI Ethernet Device Configuration utility. The utility cannot 

communicate with devices through gateways on the network and will not 

discover devices on another subnet.

I have GPIB-ENET interfaces as well as GPIB-ENET/100 interfaces. 

Why can’t I see the GPIB-ENET interfaces in the NI Ethernet Device 

Configuration utility?

The GPIB-ENET/100 uses a configuration protocol that can communicate 

with the NI Ethernet Device Configuration utility. Because GPIB-ENET 

interfaces are not compatible with this configuration protocol, the utility 

does not recognize them on the network.
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C
Specifications

This appendix describes the characteristics of the GPIB-ENET/100 and the 

transfer rates of the NI-488.2 software, along with the recommended 

operating conditions.

Electrical Characteristics
Input power requirements ...................... 9–30 VDC

Current requirements

9–30 VDC ....................................... 425 mA maximum

@ 15 VDC ...................................... 250 mA typical

Environmental Characteristics
Operating temperature............................ 0 to 40 °C

Relative humidity, operating.................. 10 to 90% noncondensing

conditions

Storage temperature ............................... –20 to 70 °C

Relative humidity, storage ..................... 5 to 90% noncondensing

conditions

EMI ........................................................ FCC Class A Verified

Physical Characteristics
Overall case size (dimensions)............... 21.0 by 12.4 by 3.7 cm

(8.25 by 4.89 by 1.44 in.)

Case material.......................................... Hard plastic with metal baseplate

Weight .................................................... 0.41 kg (0.9 lb)
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Software Characteristics
Maximum software transfer rate1 ...........Over 800 kbytes/s

Electrostatic Discharge Protection
Non-isolated devices...............................1.5 kV

Connectors
Ethernet connector ..................................RJ-45

GPIB connector ......................................IEEE 488 standard 24 pin

Network Specifications
Connection type ......................................IEEE 802.3 compliant

100BaseTX (100 Mbits/s)

10BaseT (10 Mbits/s)

Duplex mode...........................................Half duplex

1   Actual speed may vary considerably from speed shown due to system, network, and instrumentation capabilities.
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D
Technical Support Resources

Web Support

National Instruments Web support is your first stop for help in solving 

installation, configuration, and application problems and questions. Online 

problem-solving and diagnostic resources include frequently asked 

questions, knowledge bases, product-specific troubleshooting wizards, 

manuals, drivers, software updates, and more. Web support is available 

through the Technical Support section of ni.com. You also can contact our 

application engineers by visiting ni.com/ask and filling out an e-mail 

request form.

NI Developer Zone

The NI Developer Zone at ni.com/zone is the essential resource for 

building measurement and automation systems. At the NI Developer Zone, 

you can easily access the latest example programs, system configurators, 

tutorials, technical news, as well as a community of developers ready to 

share their own techniques.

Customer Education

National Instruments provides a number of alternatives to satisfy your 

training needs, from self-paced tutorials, videos, and interactive CDs to 

instructor-led hands-on courses at locations around the world. Visit the 

Customer Education section of ni.com for online course schedules, 

syllabi, training centers, and class registration.

System Integration

If you have time constraints, limited in-house technical resources, or other 

dilemmas, you may prefer to employ consulting or system integration 

services. You can rely on the expertise available through our worldwide 

network of Alliance Program members. To find out more about our 

Alliance system integration solutions, visit the System Integration section 

of ni.com.
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Worldwide Support

National Instruments has offices located around the world to help address 

your support needs. You can access our branch office Web sites from the 

Worldwide Offices section of ni.com. Branch office Web sites provide 

up-to-date contact information, support phone numbers, e-mail addresses, 

and current events.

If you have searched the technical support resources on our Web site and 

still cannot find the answers you need, contact your local office or National 

Instruments corporate. Phone numbers for our worldwide offices are listed 

at the front of this manual.
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Glossary

Prefix Meaning Value

m- milli- 10–3

c- centi- 10–2

k- kilo- 103

M- mega- 106

° degrees

% percent

A amperes

ANSI American National Standards Institute

API Application Programming Interface

b bits

B bytes

bps bits per second

C Celsius

DHCP Dynamic Host Configuration Protocol

DLL dynamic link library

DNS Domain Name Server

EMI electromagnetic interference

FCC Federal Communications Commission

g grams

GPIB General Purpose Interface Bus

Hz hertz

IEEE Institute of Electrical and Electronic Engineers

in. inches
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I/O input/output

IP Internet Protocol

LED light-emitting diode

lb. pounds

m meters

MB megabytes of memory

NIC network interface card

s seconds

V volts

VAC volts alternating current

Win16 describes a 16-bit Windows application

Win32 describes a 32-bit Windows application
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Index

A
Add GPIB Hardware Wizard

using, 2-2

adding a GPIB-ENET/100

to GPIB system, 4-1

to network, 2-5

C
cables

Ethernet connection, 2-4

GPIB cable types, 1-2

GPIB connection, 5-3

network cable types, 1-1

power connection, 2-4

caution

using firmware update utility, 6-5

CFG RESET switch

accessing Ethernet Device Configuration 

utility, 6-3

if hosts are connected, 6-4

location, 2-4

resetting default network configuration, 2-6

using at power-on, 6-4

using during operation, 6-3

changing network settings, 3-3

comment

to help identify your device, 3-5

common questions, B-4

communication problems

with driver, B-4

with Ethernet Device Configuration 

utility, B-6

Configuration Reset switch. See CFG RESET 

switch

configuring

network parameters, 3-1

NI-488.2, 4-1

connecting

cables, 2-4

GPIB devices (caution), 2-5

connection speed, 1-4

connector types, C-2

conventions, xi

customer education, D-1

D
default configuration

resetting, 2-6, 6-4

specifications, 2-3

default hostname, 2-3

development tools for saving time

GPIB Analyzer, 1-6

LabVIEW, 1-5

Measurement Studio, 1-5

DHCP

communication failure with DNS, 6-3

configuring network settings 

automatically, 2-6

configuring network settings without 

DHCP, 2-6, 3-1

confirming its availability, 2-5

failing to provide IP address, 6-3

registering hostname and IP address, 3-3

risks for failure, 6-2

time required to complete, 2-6

using, 6-2

using with DNS, 3-4, 6-2

distance capabilities, 1-3
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DNS

if not supported, 3-4

manually inserting hostname in DNS 

table, 6-3

using with DHCP, 3-4, 6-2

DNS server, 3-5

Dynamic Host Configuration Protocol. 

See DHCP

E
EDVR error conditions, B-2

electrical characteristics, C-1

environmental characteristics, C-1

error checking, B-6

error code, A-1

Ethernet address, 2-3

Ethernet connection

location, 2-4

Ethernet Device Configuration utility

accessing during normal operation, 6-3

busy device, 3-2, B-6

example (figure), 3-2

GPIB-ENET, B-6

if GPIB-ENET/100 is not listed, B-6

locating and starting, 3-1, 6-5

Refresh option, 3-3, B-6

unconfigured device, 3-2

verifying hostname, 3-7

when to use, 2-6, 3-1

Ethernet Device Firmware Update utility

using, 6-5

F
failed device

reported by PWR/RDY LED, 2-6, A-1

firmware

updating, 6-5

firmware update utility

before using, 6-5

important warning, 6-5

running, 6-6

upgrade location, 6-5

when to use, 6-5

front panel (figure), 1-3

G
gateway IP, 3-5

getting started, 1-1

Getting Started Wizard

(figure), 5-2

testing installation, 5-1

glossary, G-1

GPIB cable

connecting, 2-5, 5-3

GPIB Configuration utility

running before using NI-488.2, 4-1

GPIB connection

location, 2-4

GPIB-ENET

configuring, 2-1

installing, 2-1

using with GPIB-ENET/100, B-5

GPIB-ENET/100

installing, 2-3

properties, 3-2

H
hardware overview, 1-2

hostname

accepting DNS hostname, 3-8

changing DNS entry, 3-9

default hostname, 2-3

editing, 3-8

fixing verification error, 3-8

using to identify device, 6-3
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verification error (figure), 3-7

verifying, 3-7

viewing or changing, 3-3

I
information to record, 2-3

installation

Add GPIB Hardware Wizard, 2-2

Ethernet cable, 2-4

getting started, 1-1

GPIB cable, 5-3

GPIB-ENET, 2-1

GPIB-ENET/100, 2-3

NI-488.2, 2-1

power cable, 2-4

verification, 5-1

IP address

acquiring automatically using DHCP, 2-6

choosing static IP address, 3-5

defined, 3-5

examples of valid and invalid IP 

addresses (table), 3-6

static IP address, 6-3

IP parameters

DNS server, 3-5

gateway IP, 3-5

if assigned by network administrator, 3-5

if assigned by user, 3-6

IP address, 3-5

subnet mask, 3-5

ipconfig

using to determine network settings, 3-7

K
kit contents, 1-1

L
label

information to record, 2-3

location, 2-3

label (figure), 2-3

LEDs

description of each (table), 1-4

overview, 1-3

license

multiple-computer software license, 1-2

N
National Instruments Web support, D-1

network addresses

configuring, 4-1

network administrator

assigning IP parameters, 3-5

confirming DHCP availability, 2-5

if DHCP fails, 6-3

network configuration mode

entering, 6-3

when to use, 3-1

network settings

(figure), 4-2

changing, 3-3

configuring with DHCP, 2-6

configuring without DHCP, 3-1, 3-4

determining

in Windows 95, 3-7

in Windows Me/98, 3-7

network specifications, C-2

NI Developer Zone, D-1

NI-488.2

components, 1-5

configuration utility, 4-2

hardware support, 1-4

installing, 2-1

overview, 1-4
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